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INTRODUCTION 

In the late 1980s, when only a few million academics and govern-
mental types had easy access to a very slow Internet and even most 
business users couldn’t afford pricey Ethernet gear, we hoi polloi had 
two ways to share files: sneakernet and snail mail. The algorithm for 
sneakernet was to insert a floppy disk, copy files to the floppy, eject 
the floppy, walk (in sneakers) across the room, insert the floppy, and 
copy files from the floppy. A little tedious, but it got the job done. 

For distances beyond the reach of sneakernet, the algorithm changed. 
Instead of walking across the room, you inserted the floppy in a 
padded envelope and walked it to the post office or called FedEx. 

Even today, sneakernet and snail mail are useful for transferring huge 
quantities of data—imagine the gigabits you can “transmit” when you 
send a bunch of hard drives by overnight mail or walk a DVD-R 
across a room—but most people share files through multiple accounts 
on the same computer, over local area networks comprised of wired 
Ethernet and wireless Wi-Fi links, or over the Internet using dial-up 
modems, broadband connections, and high-speed dedicated lines. 

In Take Control of Sharing Files in Panther, I help you identify the 
right computer setup for exchanging files among users in your 
situation, with a particular emphasis on users working on networked 
computers. I focus on Mac OS X 10.3 Panther as the hub of these 
activities, but the principles are the same on all platforms, and many 
specifics are identical or quite similar in Mac OS X 10.2 Jaguar. 

I also explain how to connect to a Mac running Panther from 
Windows XP and from the Mac OS (Mac OS 9, Mac OS X 10.2 and 
Mac OS X 10.3).  
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NOTE To keep this ebook focused on file sharing, we broke out two related 

topics into full-length titles of their own: 

Take Control of Users & Accounts in Panther examines setting up 
and managing users on a Mac running Panther. 
http://www.tidbits.com/takecontrol/panther/users.html 

Take Control of Permissions in Panther, due out in 2004, will have a 
more technical focus and look at using the Terminal to configure and 
troubleshoot file permissions. 
http://www.tidbits.com/takecontrol/panther/permissions.html 

  
 

READING AND PRINTING TIPS 

We designed this ebook to be read online or printed. Here are a few 
tips to help you get the most out of your reading experience. 

Online reading tips: 

(We’re still learning the tricks for Panther’s Preview application, 
which in our testing works quite well with Take Control ebooks, so 
these tips are primarily for Adobe Acrobat and Adobe Reader.) 

• In Adobe Acrobat 5, the Take Control default settings on the View 
menu are Fit in Window and Continuous. For most people with 
larger monitors, those should be fine. To focus only on reading, in 
Acrobat 5, choose View > Full Screen, or in Acrobat 6, choose 
Window > Full Screen View. (Press Esc to leave full screen mode.) 

• Increase the size of the text by clicking the window’s Zoom button to 
make the window as wide as possible, then choose View > Fit Width. 

• To scroll using keyboard shortcuts, you must first click the main 
text area. The Page Up and Page Down keys may be the easiest 
(and they scroll by screen when you view less than a full page). The 
Left and Right arrow keys scroll to the previous and next page 
starts.  

• Blue text indicates links. You can click any item in the Table of 
Contents to jump to that section. Cross-references are also links, as 
are URLs and email addresses. 
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• Work with the Bookmarks tab showing so you can always see and 
jump to any main topic by clicking the associated bookmark.  

• You may experience a display problem wherein the top border on 
tip and screenshot layouts does not appear. The borders should 
print properly and may show properly at a different view percen-
tage. They also appear correctly in Apple’s Preview. 

Printing tips: 

• In the unlikely event that Adobe Acrobat or Adobe Reader cannot 
successfully print this PDF, try Apple’s Preview; several readers 
have solved printing problems by using Preview. 

• If you prefer a tighter layout that uses fewer pages, check your 
printer options for a 2-up feature that prints two ebook pages on 
one piece of paper. For instance, your Print dialog may have an 
unlabeled pop-up menu that offers a Layout option. Choose 
Layout, then choose 2 from the Pages per Sheet pop-up menu. You 
also may wish to choose Single Hairline from the Border menu. 

• When printing on a color inkjet printer, to avoid using up a lot of 
color ink (primarily on the yellow boxes we use for tips and 
figures), look for an option to print entirely in black-and-white. 

  
FUTURE 

UPDATES 
TidBITS Electronic Publishing may publish minor updates to this 
ebook to account for errata, software updates, new information, or 
other reasons. Such updates will be offered at no extra charge; notifi-
cation will go to the email address you gave at the time of purchase. 
Most likely, we will charge only for editions which reflect a major 
change in the underlying software; in this case, for Apple’s next 
operating system after Panther.  
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SHARING FILES QUICK START 

This ebook contains many details, not all of which may be relevant to 
your situation. You do not need to read every word before sharing 
files, but you should be familiar with the overall process first.  

Prepare to share files: 

• Before you think about the big world of sharing files on a network, 
you may wish to review techniques for sharing files among users 
on a single Macintosh. See Share Files on the Same Mac. 

• Learn how file sharing is different from using disks to copy files 
from computer to computer or using email attachments to move 
files around. See What is File Sharing? 

• Review reasons to share files, and see which match your situation. 
See Reasons for File Sharing. 

• Decide on the hardware or online service that you’ll use as your file 
sharing server; see Hardware You Need to Serve Files. 

• Determine which file sharing technique makes sense for your goals, 
budget, and expertise. See Decide on a File Sharing Technique. 

• Take steps to manage security risks by becoming informed about 
what you expose when you share files over the Internet. If you 
need to implement security measures, such as a firewall, now is the 
time to do so. See Avoid File Sharing Risks. 

Start sharing files: 

• Turn on file sharing using AppleShare, Samba, Web sharing, FTP, 
and/or WebDAV. If desired, get a few tips about turning on Unix’s 
NFS. See Turn On File Sharing and Appendix A: Share with 
SharePoints. 

• Start sharing photos and music; see Share Digital Media Files. 

Access shared files: 

• Access shared files from Panther, Jaguar, Mac OS 9, and Windows 
XP. See Access Shared Files. 
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WHAT IS FILE SHARING? 

File sharing means storing a set of files on a central computer, called 
a file server, and making it possible for any number of people to 
retrieve those files over any type of computer network, just as if those 
files were located on their own hard disks (Figure 1).  

FIGURE 1 

 

Many different 
machines can 
access a file 
server, whether 
they’re connected 
directly via Ether-
net, over wireless 
AirPort (Wi-Fi), or 
via the Internet. 

 File sharing differs from emailing one or more people a file. When 
you email a document, the recipients are passive: they check their 
email routinely, and the document arrives. The burden of distribution 
falls on you.  

File sharing eliminates the necessity of pushing a file to others. You 
place the file on a server whenever you like, and all the people who 
need to retrieve it can do so whenever they like without coordination. 
The burden of distribution falls on the recipients, who choose the 
time and method by which they retrieve the file.  
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NOTE If the word server makes you think of large computers locked in 

closets, think again. In fact, a server is just a program running on a 
computer. A server allows other individual computers to connect to 
itself for a particular task. When I talk about a server, I always mean 
a server program running on any computer. Panther has literally 
dozens of server programs available, and several relate to sharing (or 
serving) files. 

  
File sharing also solves the problem of coordinating a group of people 
working together on a document. If you don’t use file sharing and 
simply send a draft of the document via email, each recipient must 
work on her own copy of the file; when you receive all the files back, 
you must merge all the comments and changes. With appropriate 
coordination using file sharing, the shared file can be a single master 
copy, eliminating the need for manual incorporation of changes.  

A few methods of file sharing go even further to enhance collabora-
tion, either allowing people to check files out from a repository and 
locking them against other users’ modifications, or storing multiple 
older copies of a document, which lets you compare the current draft 
against older ones or restore an older copy.  

With file sharing set up, users gain access to files in two basic ways. In 
the first method, a user has an account which comprises a user name 
and a password. The user must login to his or her account by provid-
ing this user name and password through some interface to the server 
program, generally a dialog box with spaces for those two details. 
After authenticating, or proving his or her identity, the user has 
access to the shared files. You can set up one account (one user name 
and password) to share among an entire group of users or you can set 
up multiple accounts with one assigned for each user or purpose. 

In the second method, users have guest access in which they don’t 
need to authenticate themselves: no details are required, or, if they 
are required, users may enter anything they want. Their identity is 
not confirmed. With guest access, anyone who can see your server on 
the network and usually on the Internet can access the server. In 
some situations, guest access may require that the guest knows just a 
special account name, like guest or anonymous, with either no pass-
word, a password of guest, or an email address that isn’t checked as to 
whether it’s legitimate or not. 
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REASONS FOR FILE SHARING 

Now that you know the basics of what file sharing is and the 
advantages it offers, you can start taking control of sharing files by 
considering what you want to accomplish by sharing files, and with 
whom you need to exchanges files. In this section, I break out reasons 
for file sharing into a few large categories.  

  
NOTE Knowing what you want to accomplish may help you determine what 

hardware or bandwidth you need, covered in Hardware You Need to 
Serve Files. Also, it may influence your choice of a file sharing 
technique, discussed in Decide on a File Sharing Technique. 

  

Coordinate Group Projects 
When you and at least one other person need to collaborate on a 
common set of files, you can set up a central location to store the files. 
Optionally, this central location can track whether a file has been 
checked out for use. 

  
NOTE Almost always, a file server helps reduce the time, cost, and effort 

needed for routine exchanges. For one-off exchanges, you might be 
better served by sending or receiving files via techniques not covered 
in this ebook, such as email, iChat file transfer, CD-R, or USB RAM 
drive.  

  

Create a Central Archive 
Many groups have a common set of files that grows over time, but 
these files are rarely changed once they are added. In this case, many 
people may need to add to the archive without needing permission to 
delete or re-organize files, while many of the same or an entirely dif-
ferent set of people may need access to read the archive. 

Avoid Relying on Email 
Even if you’re just trying to exchange one file with one other person, a 
file server can help you step around the problems of Internet email in 
the modern age. For instance, because of viruses and worms, many 
companies and some ISPs ban all or certain kinds of attachments, 
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even from or to Mac users who can’t be infected but can accidentally 
transmit attacks by forwarding attachments.  

In other cases, you or your recipient might not be able to receive 
attachments larger than a certain size or might pay extra to store a 
mailbox with a large attachment. And for people behind relatively 
slow Internet connections, being able to choose when to start long 
downloads rather than having them delay other email is a boon. 

In any of these circumstances, a file server can help you and your 
users bypass the hassle of email. 

Distribute by Download 
File sharing includes simple downloads: perhaps you need to distrib-
ute a software product, a book in electronic form, or other data to a 
large group of people. That group could include users with accounts 
and passwords on the file server or anyone at all. 

Share Media Files 
File sharing is useful even to consumers with a couple of Macs at 
home. Many people want to share a collection of music or photos 
among a few computers; all that’s necessary is to set up file sharing 
and to configure iTunes and iPhoto properly, or—if appropriate—to 
use the built-in sharing features in these programs. See Share Digital 
Media Files to learn more. 
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DECIDE ON A FILE SHARING TECHNIQUE 

You can divide networked file sharing into roughly four categories: 

• File services built into major operating system platforms, such as 
Mac OS and Windows. If you want to jump ahead, you can find 
more details abut file services in AppleShare, SMB (Server 
Message Block) or Samba, and NFS (Network Filesystem). 

• FTP (File Transfer Protocol), a universally supported method of 
exchanging files that dates back to the Internet’s earliest days. See 
FTP (File Transfer Protocol). 

• Web downloads (and uploads!). See Web. 

• Proprietary methods that require a subscription or special client 
and server software not included with any operating system. 
Methods noted in this ebook are iDisk, IP over FireWire, Timbuktu 
Pro, BitTorrent, Adobe Version Cue, and Creo Tokens. 

Keep reading in this section to learn which approach is appropriate 
for your needs. See Table 1 for a quick overview of the methods. 

 
Table 1: Pros and Cons of File Sharing Methods for Panther Users  

Sharing 
Type 

Advantages Disadvantages 

AppleShare • Found on all Macs. 

• Free. 

• Straightforward to use. 

• Requires SharePoints (for-fee) or 
Mac OS X Server ($499 or $999) for 
any real configuration. 

• Requires extra for-fee software if 
other platforms need access. 

SMB 
(Server 
Message 
Block) or 
Samba 

• Found on all Windows systems.

• Supported under Mac OS X. 

• Free. 

• More complex than Apple-
Share, requires SharePoints 
(for-fee) or Terminal editing 
(free) to add volumes or set 
parameters. 

• Requires extra software if access is 
needed by Unix (free) or Mac OS 9 
machines (for-fee). 

• Mac users may find it baffling to 
talk Windows users through 
connecting to their volumes. 
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AVOID FILE SHARING RISKS 

Before you dig into the details of how to share your files, you should 
consider the risks of file sharing and possibly take action to avoid 
them. And, no, I’m not talking about the storm troopers of the 
Recording Industry Association of America bursting into your 
bedroom—that’s only a concern if you’re using peer-to-peer file 
sharing networks to share works for which you don’t own the 
copyright.  

Rather, you risk having unintended others accessing your files or 
abusing your storage space. This can happen even if you share files 
only over your local network; unless you set up a firewall or other 
protection, you may unintentionally leave your files available to 
outsiders. 

Problems with Open Servers 
Our Windows brethren have long been aware of the problem of acci-
dentally running an open file server, because before Windows XP, 
Microsoft’s default configuration made it easy to turn on file sharing 
without any protection. On the first cable modem networks, which 
work essentially like large Ethernet networks, people could troll 
through their neighbors’ unprotected files with abandon. Whoops. 

The Internet is so large and so fast, and full of so many jokers, that it’s 
become something like a large local network. If you purposely or 
accidentally expose more than you intended, it’s likely that some 
automated evil—a scanning program that looks for open file server 
connections—will suck down your data. Less maliciously, however, 
search engines like Google follow all links from public Web pages, 
and many Word, PDF, and other documents entered Google’s maw 
unintentionally merely by being left in an obscure but linked location 
of a Web site. 

Worse, if your computer is hijacked (taken over) by crackers, it could 
become a depository for warez, which is the slang name for pirated 
software. A number of years ago, I ran an FTP site with a few files in 
it, but I made a mistake and misconfigured it to allow both read and 
write access to anyone. A huge spike in bandwidth led me to discover 
hundreds of megabytes of pirated materials uploaded by others. Even 
though you probably wouldn’t face legal action for your negligence 
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(though that’s not a guarantee these days), you could lose time and 
money cleaning up the problem, and your ISP might sever your 
Internet connection for violation of their acceptable use policies. 

If you think unintentionally hosting pirated software is bad, it could 
be worse. Your server could also become a repository of child pornog-
raphy. Some countries, including the United States, have presumptive 
guilt. Mere possession can get you thrown in jail, fined, or otherwise 
sanctioned, and require a long process to clear your name. Several 
mainstream newspaper articles noted recently that a large percentage 
of spam and pornography is served from hijacked computers. 

There’s one more scenario that stinks: if anyone can write files to a 
drop box on your server (even if no one can read those files once 
uploaded), a malicious jerk could upload hundreds of megabytes of 
crud, saturating your available bandwidth and filling your server’s 
hard disk and making the machine unreachable until you clean up the 
unwanted files. This sort of vandalism may sound unlikely, but with 
all the hijacked computers in the world, it’s all too easy, and it does 
happen. 

Recommendations for Avoiding Risks 
I recommend that before you turn any type of file sharing on, you 
think carefully about who needs access, and what kind of access they 
need. You may also wish to set up a firewall, as discussed at the end of 
this section. 

  
TIP If you’ve never configured a file server before, you might not know 

that you can control the extent to which other users (or even yourself, 
when logged in as a user) can work with files stored on the server. For 
instance, you can let users just read files and browse folders; or just 
upload files without then seeing that they uploaded; or read, write, 
delete, and otherwise totally control a volume. 
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TURN ON FILE SHARING 

Simply turning on file sharing in Panther requires only a few clicks in 
the Services tab of the Sharing preference pane. Although this section 
explains how to use the Services tab, you may wish to review the de-
tails about the service you are about to turn on first. You can turn on 
four file sharing services from the Services tab: 

• Personal File Sharing, which is AppleShare (see Share Files with 
AppleShare for details) 

• Windows Sharing, which is Samba (see Share Files with Samba for 
more information) 

• Personal Web Sharing, which turns on the local Web server (see 
Share Files over the Web or Share Files with WebDAV for more) 

• FTP Access, which is just what it says (see Share Files with FTP to 
learn important configuration information) 

NFS requires additional configuration, which I give some pointers 
about in Share Files with NFS. 

Working in the Services tab (Figure 4), you manage each service by 
either checking or unchecking the box to the left of the service name, 
or by selecting the service’s name and clicking the Start or Stop 
button on the right side of the pane. 

FIGURE 4 

 

To turn a service on, select a 
stopped service and click Start 
at the right, or click the 
checkbox to the left of the ser-
vice. To turn the service off, 
select it and click Stop at the 
right or uncheck the checkbox to 
the left. 
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SHARE DIGITAL MEDIA FILES 

Most of this ebook discusses sharing any type of files using file shar-
ing services. However, no ebook about sharing files on a Macintosh 
would be complete without explaining how to share iPhoto and 
iTunes libraries. 

Decide How to Share Music in iTunes 
The first step in making iTunes share music is to decide whether to 
use the built-in iTunes sharing feature or to use file sharing. Here’s 
what you need to know about each: 

Built-in iTunes sharing feature 
iTunes has a built-in feature to share music which is easy to set up 
(see Use iTunes Built-in Sharing), but limited in a number of ways:  

• Music is available only when iTunes is running on the machine 
that’s sharing the music. If you turn that machine off, it crashes, or 
someone needs all its processing power for Photoshop or other 
tasks, you can’t listen to its music.  

• This method does not work for sharing music among users of the 
same Macintosh. 

• A user’s repository of music is available to others only when her 
account is logged in and active. (In the case of Fast User Switching, 
a user could be logged in, but her account could be inactive.) 

• Because Apple is playing nice with the recording industry, all you 
can do with shared music is play it from within iTunes. You can’t 
add it to your own playlists, set ratings, or edit the tags that iden-
tify each MP3 file. That’s appropriate in some situations, but in 
cases where you’re sharing your own music among your own Macs, 
such as on a home network, it’s needlessly limiting and technologi-
cally overrules U.S. law and court decisions on fair use. 

• iTunes sharing relies on Rendezvous, a technology for automat-
ically announcing network resources over a local network. But 
unlike Apple’s general use of Rendezvous in which any resource is 
available to any other on the same physical network, iTunes 
restricts its sharing to machines on the same range of Internet 
protocol (IP) addresses. Even simple home networks could have 
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two or more ranges of private or translated addresses, which 
eliminates iTunes sharing among users of them. (A typical 
scenario: a wired gateway and a wireless gateway feed out two 
different private network ranges.) A general-purpose file server 
has no such limitation, and might be appropriate for more 
complicated networks. 

Shared music folder  
This approach involves storing all your tunes in a central location, 
perhaps even a file server that doesn’t run iTunes. File sharing is 
harder to set up than the built-in iTunes sharing feature, but it is the 
only way to go if you want to share music among multiple accounts on 
the same Macintosh. It also works for sharing music across a 
network. (See Set Up a Shared Music Folder, later, to learn how to set 
up file sharing.) 

Relying on a shared music folder has the advantage of letting people 
share the same music while still creating and maintaining their own 
playlists, since the playlist information stays with each user. On the 
downside, every time someone rips a new CD or purchases new music 
online, each user must import the songs manually by dragging them 
into iTunes. The silver lining in that cloud is that each user can pick 
and choose which of the shared albums to import. 

  
TIP Sharing music over a network requires just a few hundred Kbps per 

user, so it should work fine even if you’re on a slow AirPort network 
(about 5 Mbps of throughput) or 10Base-T Ethernet (about 8 Mbps). 
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Share Photos in iPhoto 
Sharing photos in iPhoto is more complex than sharing music in 
iTunes because iPhoto is more particular about where its files live, 
and because all users need read-and-write access for importing and 
editing purposes. Sharing photos was particularly difficult until the 
release of iPhoto 4, which added Rendezvous photo sharing that 
works exactly like the comparable feature in iTunes. However, many 
people may not want to pay for iPhoto 4 (part of the iLife ’04 package 
and free with new Macs), and for others, iPhoto 4’s method of sharing 
files may not be ideal. 

  
NOTE You cannot share between iPhoto 2 and iPhoto 4; iPhoto 4 updates 

your iPhoto Library folder the first time you launch it.  

  
You must choose between two basic approaches to sharing photos in 
iPhoto: what I term the “shared iPhoto Library folder” approach, 
which works for iPhoto 2 or 4, or the iPhoto Sharing approach, an 
option introduced in iPhoto 4 that does not work with iPhoto 2. 
Which should you choose? 

• Use the shared iPhoto Library folder approach to share photos 
among users on the same Mac or if you want to ensure that all 
networked users can import, view, organize, and output the same 
set of photos. The shared iPhoto Library method is best for people 
who want to mix all their photos and work on them together. It’s 
also the only option for people running iPhoto 2. 

• Use the iPhoto Sharing approach if you want multiple users on a 
network to be able to view each other’s photos and perform limited 
output. You can print shared photos, view them in a slideshow, 
send them to others in email, order prints of them from Apple, 
upload them to HomePage in your .Mac account, and use them as 
.Mac slides. However, you cannot add someone else’s shared photo 
to albums, edit it in any way, use it in iPhoto books, use it as your 
Desktop picture or for your screensaver, create an iDVD slideshow 
with it, or burn it to CD. To accomplish any of those tasks, you 
must first copy the shared photo to your Mac first, after which it’s 
just like any other photo on your Mac. iPhoto Sharing is ideal for 
situations where each person in a family might have his or her own 
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ACCESS SHARED FILES 

Now that you’ve had the chance to read about every conceivable way 
to share files, you can learn about the complementary action: 
accessing those shared files. Let’s walk through mounting volumes or 
browsing for files on each of the major operating system versions, 
starting with Panther. 

Panther’s New Paradigm (Seriously) 
Panther 10.3.0 through 10.3.2 creates a split in the way that you 
mount shared file servers compared to earlier versions of Mac OS X—
and even System 6 through Mac OS 9.2! Under Jaguar and all 
previous releases, all file servers were hard mounted. A hard-
mounted file server appears as an icon on the Desktop (assuming you 
have that option turned on in the Panther Finder’s Preferences 
window), and is for most purposes exactly like a local hard disk. But 
with hard-mounted servers, if the server becomes unavailable—your 
network connection goes down, the server crashes—your Finder can 
lock up for quite some time, even under Panther, until it decides to 
release the missing server. 

  
NOTE In Jaguar, you reached the Network browser from the Finder by 

choosing Go > Connect to Server. In Panther, you can access the 
Network browser simply by clicking Network at the top of the sidebar 
in any Finder window.  

  
You can still hard mount servers under Panther, but Panther also 
offers an interesting, but flakey, new option for servers on a local 
network, long available in Unix: soft mounting. A soft-mounted 
server is more like a folder. Instead of it showing on the Desktop, you 
browse to it using the Network browser. If the server or your network 
becomes unavailable, Panther doesn’t complain or pause even when 
you try to access the unavailable server, of course—it’s just not there 
any more. When the server becomes reachable once again, you can 
browse that folder and find the server’s contents in it. 

  
NOTE The contents of hard- and soft-mounted servers appear and work the 

same; only the mounting process and reconnection behavior varies. 
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Access Shared Volumes with Jaguar 
Jaguar and Panther access shared files similarly even though their 
interfaces are slightly different. The main difference is the appearance 
of the Connect to Server dialog in the Finder.  

Panther splits browsing and connecting to a server into two separate 
areas; Jaguar presents these actions in the same place, and both 
browsing and connecting result in icons for hard-mounted servers 
appearing on the Desktop. To mount a server, from the Finder, 
choose Go > Connect to Server (Figure 24). 

FIGURE 24 

 

The Connect to 
Server dialog in 
Jaguar. 

 If a desired server doesn’t appear in the server list, you must enter an 
appropriate URL for it in the Address field. See Hard Mount via the 
Finder, earlier, to learn more about what you can enter here. Jaguar 
supports all the schema types listed for Panther through direct entry 
or browsing in the Connect to Server dialog. 
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